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Hot Potatoes

Công cụ kiểm tra,
đánh giá kết quả học tập

1. Khái niệm
Thông thường, khi tạo một đề thi, giáo viên thường tạo trên máy tính cá nhân sau đó đưa lên một cua học của Moodle. Điều đó là hợp lý đặc biệt trong môi trường Việt Nam khi điều kiện làm việc trên Internet còn nhiều khó khăn. 
Do vậy môđun Hot Potatoes là rất quan trọng. Môđun này giúp giáo viên cung cấp câu hỏi thi theo định dạng Hot Potatoes ( đã được soạn thảo qua các chương trình chuyên dụng - trong đề án này ta sẽ trình bày chi tiết một phần mềm miễn phí rất hiệu quả - Hot Potatoes Version 6.04) qua Moode.


Trong phần này, chúng tôi không trình bày chi tiết toàn bộ các tính năng, các thiết lập hay cách sử dụng mà chỉ tập chung về các chức năng phục vụ cho mục đích tạo bài giảng.

2. Hướng dẫn sử dụng Hot Potatoes

2.1 Giới thiệu

Hot Potatoes là một bộ chương trình tạo các bài tập cho các ứng dụng e-learning trên Web. Ta có thể tạo ra các bài tập và xuất ra theo định dạng Hot Potatoes, sau đó có thể sử dụng môđun nhập câu hỏi từ file hay Hot Pot để tạo ra các bài thi trên Moodle.

Hot Potatoes gồm các môđun:

· JQuiz: Dùng tạo các bài tập hỗ trợ 4 loại câu hỏi: Đa lựa chọn, câu hỏi trả lời ngắn, câu hỏi lai, câu hỏi nhiều câu trả lời.

· JCloze: Gồm các bài tập điền vào chỗ trống.
· JCross: Tạo trò chơi ô chữ (crosswords).
· JMix: Môđun dùng tạo các câu hỏi sắp xếp các từ /cụm từ lộn xộn thành một cụm từ/câu/đoạn theo yêu cầu. 
· JMatch: Tạo các bài tập gồm các câu hỏi so khớp hay sắp xếp các câu trả lời tương ứng với các câu hỏi. 

The Masher: Công cụ để quản lý khi có số lượng lớn các bài thi và câu hỏi.
2.1. Làm việc với Hot Potatoes


2.1.1. Khởi động và thoát khỏi Hot Potatoes
Để bắt đầu làm việc với môđun nào chọn môđun đó từ Potatoes và chọn môđun tương ứng hoặc chọn trực tiếp từ các "củ khoai" trên màn hình chính.


Để có thể sử dụng tốt phần mềm này trước hết các bạn cần hiểu rõ các định dạng câu hỏi đa lựa chọn, câu hỏi trả lời ngắn, câu hỏi lai, câu hỏi nhiều câu trả lời…(tham khảo các định dạng câu hỏi trong phần bài thi). Trong môđun bài thi Moodle cung cấp cho chúng ta công cụ soạn thảo khá đơn giản nhưng với số lượng lớn câu hỏi không đáp ứng được do một vài hạn chế như: Giáo viên soạn thảo trực tiếp trên mạng, cách soạn thảo còn khó khăn…Điều này được khắc phục với một công cụ chuyên nghiệp tạo các bài tập, bài thi như Hot Potatoes. 


2.1.2. Giao diện Hot Potatoes
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2.2. Các chức năng chung của các môđun 
2.2.1 Các chức năng chung của các môđun

Có 3 trạng thái cơ bản khi tạo một bài tập với các môđun chương trình

a) Nhập và ghi dữ liệu

Bạn nhập các thông tin như: Tiêu đề, câu hỏi, câu trả lời, thông tin phản hồi (số câu trả lời không hạn chế), các thiết lập phương án trả lời đúng và các trọng số điểm tương ứng (đối với JQuiz có 2 chế độ Beginner và advanced). Các câu trả lời được gán các trọng số điểm theo mặc định: nếu đúng thì được100% số điểm ngược lại là 0%.
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Màn hình nhập liệu JQuiz

Sau đó ghi file dưới các đuôi mở rộng tương ứng (thực ra ta sử dụng môđun nào thì tạo loại câu hỏi với đuôi mở rộng tương ứng với môđun đó):

· JQuiz:    .jqz
· JCloze:  .jcl
· JCross:  .jcw
· JMix:     .jmx
· JMatch: .jmt

Ta có thể sử dụng môđun Hotpot để nhập tạo bài thi theo định dạng 
Hot Potatoes vào các cua học của Moodle.
b) Thay đổi cấu hình

Các thông tin cấu hình thiết lập các thông số sử dụng để biên dịch trang Web. Để thiết lập các thông số cấu hình từ Options menu  chọn Configure Output. Các bài tập tạo bởi các môđun của Hot Potatoes đều có sẵn các nút nhấn và các dấu nhắc để giao tiếp với sinh viên. Các thiết lập này sẽ chung cho cả bài tập mà không phụ thuộc vào các loại câu hỏi cụ thể. Các thiết lập này rất quan trọng khi sử dụng để đưa vào Moodle sử dụng môđun Hotpot.
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Cấu hình Hot Potatoes

Các môđun có các tham số cấu hình chung bao gồm:

- Tiêu đề bài tập: Tiêu đề xuất hiện trong bài.

- Chỉ dẫn (instructions): Các chỉ dẫn này xuất hiện trên phần đầu của bài tập. Thông thường nó là các hướng dẫn cách thức làm bài.  
- Các dấu nhắc (khi trả lời đúng, sai), các thông tin hồi đáp trong các trường hợp khác nhau (đúng trong lần trả lời đầu tiên..).

- Các nút bấm: Tên, biểu tượng.
- Hiển thị: Kiểu bố trí, màu sắc…
- Timer: Thiết lập thời gian thi và thông báo khi hết giờ thi.
…

Ngoài ra mỗi môđun đều có các tham số cấu hình riêng, ta sẽ nghiên cứu chúng trong từng môđun cụ thể. 
c) Tạo trang Web

Đây là một chức năng cho phép tạo bài tập dưới dạng một trang web, sau đó ta có thể sử dụng với các mục đích khác nhau. Chú ý rằng Hot Potatoes không cho phép sửa các file theo định dạng web.

2.2.2. Các chức năng cơ bản 

a)  Thêm đoạn văn bản

Đoạn văn bản này sẽ xuất hiện trong bài thi của bạn, trong một khung khác với khung chứa câu hỏi. Đoạn văn bản này thường được dùng với mục đích gợi ý, nhắc nhở…học viên trong quá trình làm bài thi. 
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Thêm đoạn văn bản
b)  Thiết lập thời gian làm bài

Thiết lập thời gian làm bài của học viên và thông báo khi thời gian làm bài đã hết. Ta chỉ thiết lập được thời gian tối đa là 200 phút. 
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Thiết lập thời gian làm bài

c)  Thêm ảnh

Hotpot cho phép thêm ảnh vào câu hỏi, tăng thêm tính sinh động và phục vụ cho một số loại hình câu hỏi cần ảnh minh họa.

Để thêm ảnh vào một câu hỏi, tới vị trí đặt ảnh và chọn chức năng 

Insert-> Picture, có 2 cách thức thêm ảnh:

· Picture from Web URL: Chèn ảnh từ một trang web nào đó.
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Chèn ảnh từ trang web
· Picture from Local file: Chèn ảnh từ một file trên máy tính cục bộ.
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Chèn ảnh từ một file trong máy cục bộ
Các ảnh có thể được thiết lập với kích thước xác định và các chế độ căn lề.


Khi dùng môđun Hotpot của Moodle nhập vào file được tạo từ Hot Potatoes thì ảnh không được hiển thị mà chỉ hiển thị đường dẫn của ảnh. Nhưng lại hiển thị được khi xuất ra từ Hot Potatoes theo định dạng V6.
d)  Thêm một liên kết


Chèn một liên kết tới một điạ chỉ trang web (Insert->Link-> Link to Web URL) hay một vị trí nào đó trong máy tính cục bộ (Insert->Link-> Link to Local File).

e)  Thêm âm thanh và hình ảnh


Chọn Insert->Media Object. Chọn đường dẫn tới file media, các phần mềm sử dụng để chơi file media này, dòng văn bản chứa đường liên kết tới file.
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 Chèn file media
Sau đây là hình ảnh minh họa sau  khi chèn ảnh, link, media.

[image: image8.png]Fillin all the gaps, then press "Check to check your answers. Use the "Hint" button to get a free letter if an answer is giving you
trouble. You can also click on the "[7]" button to get a clue. Note that you will lose points if you ask for hirts or clues!

Dur¢i day la mot bai tho clia Puskin

Anhyéu em nay chirmng co thé

Ngon liva tinh chira hén da tan ]
Nhung khong dé em Iong thém niva
Hay em phai gon uhoai
cong thuong mai dien tu bo giao duc dao tao

Mong Uoc Ky Niem Xua (Tam Ca 3A)

Check Hint.





 Minh họa câu hỏi khi đã thêm các đối tượng: văn bản, âm thanh, ảnh
2.3. Làm việc với JQUIZ

2.3.1 Khởi động JQUIZ
Môđun này cho phép soạn thảo bài tập với 4 loại câu hỏi: Đa lựa chọn (Multiple-choice), câu hỏi trả lời ngắn (Short- Answer), Câu hỏi lai (Hybrid), Câu hỏi nhiều câu trả lời (Multiple- Select).

Để khởi động JQuiz  chọn Potatoes -> JQuiz, hoặc có thể kích vào biểu tượng JQuiz. Thì màn hình sau xuất hiện
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Giao diện JQuiz


Trong màn hình soạn thảo bạn có thể chọn  một trong các định dạng câu hỏi để bắt đầu. Trước hết, các bạn cần hiểu rõ các định dạng câu hỏi đa lựa chọn, câu hỏi trả lời ngắn, câu hỏi lai, câu hỏi nhiều câu trả lời (tham khảo các định dạng câu hỏi trong phần bài thi).

Multichoice-question: học viên chọn 1 câu trả lời đúng thông qua click vào button. Nếu câu trả lời đúng thì chú thích trên button sẽ là hình ( và câu trả lời sai sẽ thay đổi thành dấu X. Bạn có thể thay đổi cấu hình của chúng bằng cách chọn Manage Question -> thẻ Prompts/Feedback . Và ở dạng câu hỏi này học viên sẽ thấy được lời phản hồi của câu trả lời rằng tại sao đúng và tại sao sai. (nếu không thích lời phản hồi mặc định của hệ thống thì giáo viên có thể đưa ra lời phản hồi khác khi soạn bài tập). Nếu câu trả lời sai, học viên có thể tiếp tục chọn câu trả lời cho đến khi câu trả lời đúng được chọn. Điểm của mỗi câu hỏi sẽ được tính trên số lần sinh viên thử để có được câu trả lời đúng (chọn sai thì trừ đi dần số điểm ). ……..

Short answer question: học viên phải đánh câu trả lời vào textbox trên trang bài thi. Và click vào nút check để thấy được nếu nó là câu trả lời đúng. Trang bài thi sẽ kết nối câu trả lời của học viên với đến danh sách đáp án hoặc câu trả lời không đúng mà bạn đã định nghĩa trước đó. Nếu một từ hợp nhau được tìm thấy, lời phản hồi cho câu trả lời sẽ hiển thị. Nếu không thì trang sẽ tìm từ hợp nhau nhất với câu trả lời đúng mà bạn định nghĩa, tín hiệu sẽ thông báo cho học viên rằng bộ phận nào sai bộ phận nào đúng. Số điểm của mỗi câu hỏi là căn cứ trên số lần mà sinh viên đã làm thử trước khi trả lời đúng. Học viên cũng có thể sử dụng nút Hint để biết được một từ của câu trả lời. Sử dụng button  Hint học viên sẽ bị trừ bớt đi số điểm của mình.

Hybric question: câu hỏi ghép là sự kết hợp của một câu hỏi có đa lựa chọn với một câu hỏi trả lời ngắn.

Multi-select question:  cuối cùng một câu hỏi nhiều lựa chọn yêu cầu người học lựa chọn các mục trả lời cụ thể. Ở đây người học lựa chọn tất cả các mục lựa chọn đúng và không lựa chọn tất cả các mục sai.

Các thông tin chung khi soạn thảo đã trình bày ở phần trên. 

Khác với các môđun  khác, môđun JQuiz có 2 chế độ soạn thảo: Beginner và Advanced.


Chế độ Beginner (Option-> Beginner mode) tương tự như chế độ soạn thảo của các môđun  khác, trọng số điểm các câu hỏi đúng là 100% và sai là 0%, được thiết lập bằng cách chọn hộp lựa chọn "correct" cho câu trả lời đúng. Đối với câu hỏi nhiều câu trả lời (Multiple- select) thì chọn tương ứng "should be selected" .
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Chế độ soạn thảo Beginner

Chế độ Advanced sử dụng với những người dùng hiểu định dạng của các câu  hỏi. Khi đó, ta có thể thiết lập trọng số điểm cho từng phương án trả lời trong mỗi câu hỏi. 


Chú ý rằng tổng trọng số điểm của các phương án trả lời đúng nên nhỏ hơn 100%, nếu không sẽ phát sinh lỗi khi sử dụng bài tập này (tham số Weighting). Chọn "Accept as correct", khi chấp nhận phương án đúng nhưng với trọng số khác 100%. 
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Chế độ soạn thảo Advanced

2.3.2 Chi tiết quá trình nhập liệu JQUIZ



Title: tựa đề của bài tập hoặc câu hỏi mà bạn đang soạn. Nó sẽ trở thành tựa đề chính của trang web mà bạn tạo.

Text box nhập nội dung câu hỏi: Nhập nội dung câu hỏi vào trong textbox này. Chuyển sang câu hỏi khác bằng cách click vào button Up and Down(hoặc sử dụng nút Page Up, Page Down trên bàn phím)

Question type: chọn loại câu hỏi muốn soạn thảo.

Answers: nhập nội dung câu trả lời nhiều chọn lựa vào các textbox bên dưới Answer. Bạn có thể tạo nhiều hơn 4 câu trả lời bằng cách click vào button Up and Down bên trái Answer để tiếp tục đến các nhãn trả lời F,G,H…. Bạn cũng có thể chỉ tạo 2,3,4 câu trả lời như bạn muốn ,hệ thống sẽ bỏ qua những textbox trống đó khi tạo ra trang web.

Feedback: câu phản hồi có thể được thay thế bằng câu khác nếu bạn không muốn mặc định hệ thống đưa ra.


Correct: check vào checkbox correct nếu bạn chấp nhận câu trả lời đúng. 

2.3.3. Các công cụ hỗ trợ khác của JQUIZ

JQuiz cung  cấp công cụ giúp quản lý các câu hỏi Manage Questions: bố trí, di chuyển, xóa, tự động trả lời.

Để có thể xem vị trí sắp xếp các câu hỏi chọn: Manage Questions->view quiz outline. Ta có thể sắp xếp lại vị trí các câu hỏi bằng các kéo và thả tới vị trí tương ứng.
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Quản lý câu hỏi

Ngoài ra ta có thể xóa một câu hỏi : Manage Questions-> delete question
[image: image13.png]Delete question nurmber |





Xóa một câu hỏi
Tương tự khi thêm một câu hỏi, tráo đổi vị trí 2 câu hỏi cho nhau.  
Chức năng "auto-response" tự động chèn các thông tin phản hồi cho các phương án trả lời đúng/sai. Đây là chức năng trợ giúp thuận tiện khi phải tiến hành soạn thảo một số lượng lớn các câu hỏi. 
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Tự động điền các thông tin phản hồi

Khi tạo nhiều bài thi, ta có thể trộn một số câu hỏi để tạo ra sự khác biệt, điều này rất phát huy tác dụng khi tiến hành thi để tránh trùng lặp hoàn toàn trong đề thi của mỗi học viên thậm chí trong các lần thi của một học viên. Ngoài ra còn có chức năng trộn các câu trả lời của từng câu hỏi.


Cũng có  một vài điểm cần chú ý trong cách cấu hình file xuất ra. Ngoài các thông tin về tiêu đề, chỉ dẫn, các nút bấm, .. là các thông tin chung ta đã nghiên cứu ở phần trên, ta quan tâm đến các thông số riêng cho môđun JQuiz. Các thông tin này chứa trong tab other của màn hình configuration: 

· Số câu hỏi tối đa hiển thị mỗi lần trang được tải  lên.

· Các tùy chọn cho phép trộn thứ tự các câu hỏi hay câu trả lời.

· Xem điểm sau  khi trả lời đúng 

· Xem danh sách các câu trả lời đúng

· .... 
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Cấu hình JQuiz

Dưới đây là một bài tập được tạo bởi môđun JQuiz
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Bài tập được tạo bằng môđun JQuiz

(đây là chế độ soạn Advance tôi chọn là nam bộ chấp nhận 50% là đáp án đúng thì được giao diện trên)
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2.4. Làm việc với JCLOZE
2.4.1. Khởi động JCLOZE

Cung cấp công cụ tạo các câu hỏi điền từ vào chỗ trống
Để khởi động JCLoze chọn Potatoes -> JCLoze, hoặc có thể kích vào biểu tượng JCLoze. Thì màn hình sau xuất hiện.
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2.4.2. Chi tiết quá trình nhập liệu.

[image: image19.png]& | ICloze: [Untitled]
Ble Edt Iwert Options Hep

aeHB RV B &

Title Bai tap dién khuyét

[Bii tho sau cia tac gia Han Mac Tir

Sau ank khang v& chai thén v
INHin nang hang cau nng e lén
IVirtrn ai murdrc qua xanh nhir ngoc
L tric che ngang mat chir ién

& Delete Gap ‘

Clear Gaps o Auto-Gap ‘ <8 show Words

Config: engishé.cfg





Title: nhập vào tựa đề bài tập. Nó sẽ trờ thành tựa đề chính của trang web mà bạn tạo.

Textbox nhập nội dung câu hỏi: Nhập nội dung bài tập điền khuyết vào đây. Bạn có thể nhập một đoạn văn hoặc từng câu một nếu bạn muốn tạo ra một chuỗi các câu hỏi. Để tạo ra một từ khuyết trong văn bản bạn phải chọn một từ hoạc một cụm từmà bạn muốntạo và kế đến bạn chọn nút “Gap”. Khi đó từ mà bạn muốn tạo chuyển sang màu đỏ. Và một dialog sẽ xuất hiện để bạn có thể soạn đáp án cho từ điền khuyết đó.
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Trong màn hình này ta thiết lập cho đoạn trống: trợ giúp, các hướng dẫn, các đáp án đúng có thể. 

Ta có thể xóa một khoảng trống sử dụng "Delete Gap", xóa toàn bộ sử dụng"Clear Gaps".

Khi sử dụng chức năng "Auto- Gap" với câu hỏi nhúng cả hình ảnh và các liên kết thì JCloze coi cả đoạn văn bản thể hiện các liên kết là câu hỏi và điền cả các ô trống vào phần này.

Cấu hình JCloze: Ngoài các tham số cấu hình chung đã được nghiên cứu ở phần trên, ta phải quan tâm các tham số sau:  

Trong tab "Other":
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Cấu hình JCloze

· Chọn "Use dropdown  list instead of textbox in output" để thay đổi cách hiển thị khoảng trống trong câu hỏi từ dạng hộp sọan thảo thành danh sách đổ xuống. Khi đó nút bấm "Hint" sẽ bị ẩn, và chức năng định hướng "[?]" cũng mất tác dụng.

· Chọn " Include list word with text" sẽ hiển thị danh sách các đáp án điền vào các khoảng trống. Điều này sẽ làm cho bài thi dễ dàng hơn.

· "Make answer- checking case sensive", tắt hay bật trạng thái phân biệt chữ hoa chữ thường.

Chọn số khoảng trống được hiển thị cho mỗi hộp soạn thảo.
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dạng textbox
[image: image23.png]Bai tho sau clia tac gid Han Mac T

Sau

| khéng vé chai thon vi

Nhin néng
Yuan ai

¥ néng méi 1én

| xanh nhu ngoc

Latric

| mat chir dién

Check






dạng list

(chon list hay text vào option->configure output->other)

Ngoài ra môđun JCloze còn cho phép xuất ra theo định dạng WebCT(đã nghiên cứu ở trên). 

2.5. Làm việc với JMATCH
JMatch là môđun tạo các câu hỏi so  khớp tức là chọn tương ứng giữa 2 phần của một câu hỏi. Trong mỗi câu hỏi cố định một tập các đối tượng (giả sử gọi  là A), cho trước một tập các đối tượng khác (giả sử gọi  là B). Câu hỏi yêu cầu chọn tương ứng các phần tử giữa 2 tập hợp này. 
2.5.1. Khởi động JMatch

Để khởi động JMatch chọn Potatoes -> JMatch, hoặc có thể kích vào biểu tượng JMatch. Thì màn hình sau xuất hiện.
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2.5.2. Chi tiết quá trình nhập liệu JMATCH
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Title: nhập vào tựa đề của bài tập. Nó sẽ trở thành tựa đề chính của trang web mà bạn tạo.

Fix: cố định vị trí 

Left items: đây là những mục được xuất hiện bên trái trong trang web của bạn. Chúng cũng có thể là ảnh, hoặc những link. Những mục bên phải sẽ kết hợp với chúng.


Rightitems: đây là những mục xuất hiện bên phải trong trang web mà bạn tạo và nó sẽ được hoán đổi vị trí. Và chúng ta có thể xuất ra nhiều định dạng khác nhau để có được nhiều format khác nhau.

2.5.3. Các công cụ hỗ trợ khác

JMatch cho phép xuất ra 2 loại câu hỏi so khớp khác nhau theo định dạng web V6.

· Câu hỏi so khớp kéo thả: Loại câu hỏi người dùng trả lời bằng cách kéo các phần tử trong tập B đặt tương ứng với các phần tử trong tập A. Xuất ra theo định dạng này bằng cách từ menu File chọn Create web  page -> Prag Drop format [image: image26.png]Cau héi ghép doi
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JMatch Drag/Drop
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Câu  hỏi kiểu lựa chọn thứ tự: Các phần tử trong tập B nằm trong các danh sách lựa chọn  ứng với  mỗi phần tử của tập A. Xuất ra theo định dạng này bằng cách từ menu File chọn Create web page -> Standard format
JMatch list

Ngoài ra ta cũng có thể xuất ra theo định dạng Flashcards
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Ngoài ra JQuiz cũng cung cấp chức năng đưa ra theo định dạng WebCT tương tự như môđun JCloze. Chức năng thêm các câu hỏi vào file cho phép ghép thêm vào file các file khác theo định dạng JQuiz (chọn File->Append File).

Ngoài các công cụ tương tự như các môđun khác, JMatch có thêm một vài công cụ như cho  phép  tráo đổi vai trò của 2 tập A và B, tạo trang web với nhiều định dạng  khác. 


Tráo đổi vai trò của 2 tập A và B tức là đưa các phần tử bên trái sang bên phải của  màn hình soạn thảo và ngược lại.(option ->right to left)


Hoán vị vị trí của các item để tạo ra nhiều bài tập không trùng lặp như sau: Manage item -> shuffle items
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2.6. Làm việc với JMIX
JMix cung cấp một hình thức bài tập phổ biến đặc biệt phục vụ cho các cua học ngoại ngữ. Đó là hình thức sắp xếp các từ, cụm từ thành một câu, hay các câu một cách hợp lý.

2.6.1. Khởi động JMIX

Để khởi động JMix chọn Potatoes -> JMix, hoặc có thể kích vào biểu tượng JMix. Thì màn hình sau xuất hiện.
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2.6.2. Chi tiết quá trình nhập liệu
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Title: cung cấp tên câu hỏi.

Main sentence: đây là nơi mà giáo viên nhập câu hỏi chính là các phần câu hỏi đã được xáo trộn sau đó yêu cầu người làm sắp xếp lại. Mỗi phần được đặt trên một dòng, chú ý các dấu câu  cũng là một phần của câu.
Alternate sentence: là câu trả lời đúng hay đáp án. Bạn có thể tạo ra nhiều câu lựa chọn đúng. Ví dụ, nếu câu chính của bạn là “The potato, a root vegetable, is a staple, foot in England . ”. Thậm chí bạn có thể soạn câu đáp án mà không dùng hết những từ và những chấm câu trong câu chính nếu bạn muốn. VD, “The potato is a root vegetable .”
JMix có thể cho phép câu không sử dụng hết toàn bộ các phần trong "Main sentence" hay không thông qua tùy chọn "Alow sentences which do not use all words and punctuation in main sentence .". Nhưng bạn phải chọn hai tùy chọn bên dưới như:
- Cho phép câu không sử dụng tất cả các từ và dấu chấm câu trong câu

- Cảnh báo nếu câu lựa chọn không sử dụng tất cả các từ và dấu chấm câu.

Tuy nhiên, nếu mà bạn nhập một câu mà nội dung chứa một từ hoặc một dấu chấm câu mà không tồn tại trong câu chính thì chương trình sẽ báo lỗi.

Các chức năng khác của JMix cũng tương tự như các môđun khác.

Sau đây là câu hỏi mẫu:
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Import:
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Check Undo Restart Hint.









Dạng standard
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Mixed-up sentence exercise

to form a sentence. When you think your answer is correct, click on "Check” to check your anst
stuck, click on "Hint" to find out the next correct part.

Check Restart Hint.

is || what || this






Kết quả thục hiện
 

2.7.  Làm việc với MASHER
2.7.1. Khởi động Masher
Masher là một công cụ được thiết kế trợ giúp bạn quản lý một số lượng lớn các bài tập hotpot. Nó biên dịch tất cả các loại bài tập được tạo ra bởi các môđun của hotpot tạo thành một đơn vị,  tạo ra mục lục và các liên kết để dễ dàng trong việc thao tác.
Để khởi động Masher chọn Potatoes -> Masher hoặc có thể kích vào biểu tượng Masher. Thì màn hình sau xuất hiện.
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 Màn hình soạn thảo Masher

2.7.2. Tạo ra đơn vị liên kết bằng JMATCH
Thêm các file bạn muốn biên dịch: Trong màn hình chính chọn tab " File",  nhấn nút "Add files" sau đó chọn các file bạn muốn. Có thể xóa các file trong danh sách bằng cách chọn file và nhấn nút "Delete file". Ta cũng có thể thay đổi thứ tự các file bằng các phím mũi tên bên phải. 

Chỉ định thư mục lưu trữ (output folder): Chọn thư mục lưu trữ các file được biên dịch.  

Thiết lập các cách thức hiển thị trong tab "Appearance": ta có thể chọn cách hiển thị chung cho tất các các file, hay các cách hiển thị riêng được lưu trong cấu hình file.

Thiết lập các chuỗi trong táp "User strings", Các nút bấm trong táp "Buttons", file nguồn trong táp "Source", tiêu đề và tên file chỉ số trong táp "Index"

Sau khi thiết lập xong chọn "Build unit " để thực hiện công việc.

Đây là hình ảnh file "index":
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File Index được tạo ra bởi môđun Masher

Với phiên bản không đăng ký chúng ta chỉ có thể kết hợp tối đa 3 file thành một, nhưng mã đăng ký lại không sử dụng trùng với user name và key với Hot Potatoes.
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